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Declaration of conformity

We, NOKIA MOBILE PHONES Ltd declare under our sole responsibility that the product NOKIA MUSIC PLAYER,
HDR-1 is in conformity with the provisions of the following Council Directive: 89/336/EC and 1999/5/EC.

Copyright © Nokia Mobile Phones 2001. All rights reserved.

Reproduction, transfer, distribution or storage of part or all of the contents in this document in any form without the
prior written permission of Nokia is prohibited.

Nokia and Nokia Connecting People are registered trademarks of Nokia Corporation. Other product and company
names mentioned herein may be trademarks or tradenames of their respective owners.

Nokia operates a policy of continuous development. Nokia reserves the right to make changes and improvements to
any of the products described in this document without prior notice.

Under no circumstances shall Nokia be responsible for any loss of data or income or any special, incidental, conse-
quential or indirect damages howsoever caused.

The contents of this document are provided “as is”. Except as required by applicable law, no warranties of any kind,
either express or implied, including, but not limited to, the implied warranties of merchantability and fitness for a
particular purpose, are made in relation to the accuracy, reliability or contents of this document. Nokia reserves the
right to revise this document or withdraw it at any time without prior notice.

Music is copyright protected in international treaties and national copyright laws. It may be necessary to obtain
permission or a license to reproduce or copy music. In some countries national law prohibits private copying of
copyrighted material. Please check the national legislation of the applicable country concerning the use of such
material.

The availability of particular products may vary by region. Please check with the Nokia dealer nearest to you.
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Introduction - For your safety

Read these simple guidelines. Breaking the rules may be dangerous or illegal. Further detailed
information is given in this manual.

Please refer to the user guide of the phone for instructions on operation, care and mainte-
nance, including important safety information.
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Road safety comes first
You can connect your Nokia mobile phone to the Nokia Music Player but do not use
the phone while driving; park the vehicle first.

Interference
All wireless devices may get interference which could affect performance.

Switch off in hospitals
Follow any regulations or rules. If you have a Nokia mobile phone connected to your
Nokia Music Player, switch the phone off near medical equipment.

Switch off in aircraft
Wireless devices can cause interference. Switch off your Nokia Music Player and
Nokia mobile phone while onboard aircraft. Using them on aircraft is illegal.

Switch off when refueling
Do not use phones at refuelling points. Do not use near fuel or chemicals.

Switch off near blasting
Do not use phones or radios where blasting is in progress. Observe restrictions, and
follow any regulations or rules.

© 2001 Nokia Mobile Phones.
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Introduction - For your safety
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Use qualified service
Only qualified service personnel must install or repair equipment.

Accessories and batteries

Use only approved accessories and batteries. Do not connect to incompatible prod-
ucts.

Connecting to other devices

When connecting to any other device, read the user’s guide for detailed safety instruc-
tions. Do not connect incompatible products. Remember to make backup copies of all
important data.

Listening volume

We want you to enjoy your music but please be careful not to play your music too
loud. Continuous loud noises can damage your hearing. Please use care when select-
ing your listening volume.

Headphones and neckstrap
Do not use the headphones or the neckstrap when it would not be safe to do so.

© 2001 Nokia Mobile Phones.
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Introduction - Uses of your Nokia Music Player

There are three different ways of using your Nokia Music Player.

Stand-alone player
Your Nokia Music Player can be used by itself as a small, portable, high-quality, playback
device. For information about using your Nokia Music Player as a stand-alone player see
Nokia Music Player - Memory card playback.

Connected to your Nokia mobile phone
When connected to your Nokia mobile phone the Nokia Music Player allows hands-free
operation of the phone. You can receive calls and dial out without touching your Nokia
mobile phone. For information about using your Nokia Music Player with your Nokia mobile
phone see Nokia Music Player — Using as a hands-free headset.
Note: Because the same cable port is used for both connections to your Nokia
mobile phone and your personal computer it cannot be used to connect to
both devices at the same time.

Connected to a compatible PC
The Nokia Music Player receives from your PC new music files, downloaded directly to the
memory card in the Nokia Music Player. For information about using your Nokia Music
Player when connected to your PC starts see Nokia Audio Manager — Usage or Nokia CD

Manager.
Note: Do not use this product improperly to violate anyone’s copyrights or other
rights in the music you download or play.
The license is system specific. If you plan on using the software on multiple
computers, you must register on each computer.
8 © 2001 Nokia Mobile Phones.
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Introduction - Contents of the sales package

Nokia Music Player AAA Battery, (1)

NOKIA

nnnnnnnnnnn

Neck strap

——

Phone cable

NOKIA

MUSIC PLAYER

Headphone cable

CD-ROM jacket
Memory card
Warranty card (not shown)
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Introduction - Your Nokia Music Player diagram
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Software choices

You must choose between these two pieces of software to manage your music.
Note: The Nokia CD Manager and the Nokia Audio Manager were not developed
to be used at the same time. Please close one before using the other.

Nokia CD Manager

Nokia CD Manager allows you to copy music from an audio CD, rename the tracks, and
transfer the music to your Nokia Music Player. No Internet connection is needed.

Easy to use

® CD read management

e Simple download to Nokia Music Player

® AAC 64 kpbs only supported (64 kpbs is one hour on a 32MB memory card.)

Nokia Audio Manager

Nokia Audio Manager is a complete music manager that allows you to copy music from audio
CDs (reading), get music from the Internet, create a database of your music and transfer to
your Nokia Music Player. A connection to the Internet is necessary for access to the CD
Database with Nokia Audio Manager.

Main features

e CD Reader (AAC)

® Database management (multiple formats: MP3, AAC, etc.) including legacy MP3 files
e Download to Nokia Music Player

¢ Internet connection (downloading music)

11

© 2001 Nokia Mobile Phones.
All rights reserved.



Getting and listening to music

Get music

l No Internet connection
Internet connection Basic users

¥ 4

Nokia Audio Manager Nokia CD Manager
Install J
Installation Installation
J Read a CD J
See How to See Read a
read CDs CDh
J Make playlists J
See Making a See Rename
custom playlist tracks
Copy to Nokia
l Music Player l
See Transferring See Copy to
music to your player and
memory card listen to music
I Listen to music I

See Memory card playback
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Quick & Easy

Nokia CD Manager

Install Nokia CD Manager
Insert the CD-ROM into your personal computer. Install by choosing icon on Main Menu. An
Internet connection is not used.

Note: Do not connect your Nokia Music Player to your personal computer before
installing Nokia CD Manager.

Before you can connect the music player, see Getting Started to learn how to:
e install the battery,
e attach the headphone cable,
e insert the memory card.

Connect your Nokia Music Player
Connect the USB cable to the Phone/PC connector and the USB port on your personal com-
puter.

Turn on your Nokia Music Player
Slide the audio/off switch to audio.

Start Nokia CD Manager
Select Nokia CD Manager from the start menu.

Insert a music CD
Insert a music CD into your personal computer.

Select tracks
Click on track titles to select tracks to transfer to your personal computer.

13 © 2001 Nokia Mobile Phones.
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Quick & Easy

Transfer tracks from the CD
Click on Read a CD to transfer the selected tracks to your personal computer.

Rename tracks
Right-click on a track. Enter track titles or rename tracks.

Save your renamed tracks
Click on Rename to close the box and save your renamed title.

Copy to your Nokia Music Player
Select tracks from the left side of the screen to transfer to your Nokia Music Player. Click Add.
The selected tracks are transferred to your Nokia Music Player.

Nokia Audio Manager

Install Nokia Audio Manager
Insert the CD-ROM into your personal computer. Install by choosing icon on Main Menu.

Note: Before you can connect the music player, see Getting Started to learn how to:
e install the battery,
e attach the headphone cable,
e insert the memory card.

Connect your Nokia Music Player
Connect the USB cable to the Phone/PC connector and the USB port on your personal com-
puter.

14 © 2001 Nokia Mobile Phones.
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Quick & Easy

Turn on your Nokia Music Player
Slide the audio/off switch to audio.

Start Nokia Audio Manager
Select Nokia Audio Manager from the start menu.

Insert a music CD
Insert a music CD into your personal computer.

Get tracks from the CD
Click on make a playlist, then read a CD.

Get track titles from the CD Database

If track titles have not been recorded on the CD, Nokia Audio Manager will ask if you want to
download the track titles from the CD Database on the Internet. Click Yes. You will need an
Internet connection.

Select track/tracks
Click in the box next to the track/tracks you wish to copy to the music database.

Start reading tracks
Click Start Reading. When all selected tracks are copied, Recording completed successfully is
displayed. These tracks have been added to your database of music tracks.

Select tracks from the database
Click Select Tracks From Database.

Select tracks for the playlist
Click in the box next to the track/tracks you wish to copy to add to the playlist then click OK.

15
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Quick & Easy

Save the selected tracks to a playlist
Click Save Tracks as Playlist and enter a name for the playlist. Click Close.

Copy to your Nokia Music Player
Click copy to devices.

Select tracks or playlists to copy to your Nokia Music Player
Click Select Tracks From Database or Select Playlists From Database and click in the box next
to the tracks or playlists you wish to copy to the Nokia Music Player then click OK.

Copy to your Nokia Music Player

Confirm that your Nokia Music Player is on. Click Copy To Portable. Sending to device is
displayed and a progress window appears. When the copy is finished, Finished transferring
tracks is displayed. Click OK.

Nokia Music Player

Turn on the music player (Standby mode)
Slide the audio/off switch to audio.

Begin playback
Press >/0.

Adjust volume
Press the volume button up + or down —.

Pause playback
While a track is playing, press >»/D.

16
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Quick & Easy

Resume playback
While a track paused, press >/0.

Select tracks
Press 2> with one quick press to move to the next track. Press €€ with two quick presses to
move to the previous track.

Scanning tracks
Press and hold €€ or >.When you release €€ or >3, playback begins again.

FM radio

Turn on the music player
Slide the audio/off switch to audio.

Select playback from the FM radio
Press and hold the mode key for several seconds until is displayed.

Select a frequency
Press €€ or 2> until the desired frequency is tuned in.

Adjust volume
Press the volume button up + or down -.

17
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Quick & Easy

Hands-free headset
Before you can use the music player as hands-free headset, connect your Nokia Music Player
to your Nokia mobile phone. See Connecting your Nokia Music Player and phone.

Receive a call
Press 2 for a second.

Placing a call (only Nokia mobile phones 3310 and 8890)
1. Press and hold the 2 until the voice starting tone is heard through the headphone.
2. Speak the name of the number already recorded in your Nokia mobile phone.

End call
Press the 7.

18 © 2001 Nokia Mobile Phones.
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Install Nokia Audio Manager

Installation
These are the minimum requirements to successfully install Nokia Audio Manager:

Item Requirement
PC IBM PC/AT compatible.
CPU Pentium MMX 266 MHz required. Pentium 300 MHz recommended.
Memory Minimum 48 MB recommended. 64 MB suggested for Windows 2000.
Hard disk 35 MB of free space is required to install the software. Additional free space is
necessary for music files.
Note: If you do not have an Internet connection, please refer to Install Nokia CD
Manager.

Do not connect your Nokia Music Player to your personal computer until after
either Nokia Audio Manager or Nokia CD Manager has been installed.

The installation process starts by clicking on Install the Nokia Audio Manager button in the
Set-up Program (Install program) for the Nokia Music Player on the CD-ROM.

Load CD-ROM into your personal computer

Quit all other applications and then load the CD-ROM you received with your Nokia Music
Player into your personal computer. Please refer to the user manual you received with your
personal computer for more information. Nokia Audio Manager is automatically installed onto
your hard disk after choosing the install button on the Main Product Menu. Follow on-screen
instructions to successfully complete installation.

19
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Install Nokia Audio Manager - Install error

Uninstall Nokia Audio Manager

Automatic Nokia Audio Manager uninstall (from Start menu)
Select Start > Programs > Nokia > Nokia Audio Manager > Uninstall Nokia Audio Manager.

b Mokia Audio Manager
ﬁ! Uninstall Mokia Audio Manager

[#] Favonites
@rouments
@ Settings
%) Find

& Help
ﬂﬁun...

42, Log OF Scotthe...

~ v ~ = R

Follow the dialog boxes until you have successfully uninstalled Nokia Audio Manager.
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Install Nokia CD Manager

Installation

The installation process starts by clicking on Install the Nokia CD Manager button in the Set-
up Program (Install program) for the Nokia Music Player on the CD-ROM.

Load CD-ROM into your personal computer

Quit all other applications and then load the CD-ROM you received with your Nokia Music
Player into your personal computer. Nokia CD Manager is automatically installed onto your
hard disk after choosing the install button on the Install Nokia Audio Manager screen. Follow
on-screen instructions to successfully complete installation.

Note: Do not connect your Nokia Music Player to your personal computer before
installing Nokia CD Manager.

‘Welcome x|

‘Welcome to the Nokia CD' Manager Setup progiam. This program will install
MNokia CD' Manager on your computer.

It i strongly recommended that pou exit &l Windows programs before
runhing this Setup program,

Click Cancel to quit Setup and then close any programs you have wnning.
Click Mext to continue with the Setup program

WARMIMG: This program is protected by copyright law and intemational
treaties.

Unautharized reproduction ar distribution of this program, or any partion of it,
may result in severe civil and criminal penalties, and will be prosecuted to
the maximum extent possible under law.

< Back I Mext » I Cancel
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Install Nokia CD Manager

Choose Destination Location

Setup wil install Mokia CO' K anager in the following directony.
Tao install to this directory, click Mext.
To install ta a different directary, click Brawse and select anather directony.

“f'ou can choose not to install Mokia CD Manager, by clicking Cancel ta exit
Setup.

" Drestination Directory

|C:\F'r0gram Files\NokiséCD Manager Browse... |

Space Required: 2402 K
Space Available: 15873333 K

< Back I Next » I Cancel

The destination directory for the program files is C:\Program Files\Nokia\CD Manager. Click
Next> to continue. It is recommended that you use this directory due to links to program

executables.

22
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Install Nokia CD Manager

Setup iz complete and Mokia CD Manager is now installed!

Click Claze ta end the Setup

< Back I Clase I

Lance

Installation is complete. Click Close.

23
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Install Nokia CD Manager - Install error

Uninstall Nokia CD Manager
Automatic Nokia CD Manager uninstall process (from Start menu)

On CD Manager installation failure click Cancel.
Select Start > Programs > Nokia > Nokia CD Manager > Remove Nokia CD Manager.

Bm HOKIA CD Manage Nokia CO Manager

Windows 2000 Server

start || ] & E3 || Sinstaller

Follow the dialog boxes until you have successfully uninstalled Nokia CD Manager. After
uninstalling Nokia CD Manager try the installation again by clicking on Install the Nokia CD
Manager button in the Set-up Program (Install program) for the Nokia Music Player on
the CD-ROM.

24 © 2001 Nokia Mobile Phones.
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Nokia Music Player - Getting started

There are a few short steps to get ready to use your Nokia Music Player. Follow the steps
carefully.

Installing the battery

Remove the battery cap

Hold the Nokia Music Player with the back of the player facing you. Press down on the
battery cap (D and pull the battery cap towards you (2), in the direction of the arrows on top
of the battery cap. Carefully fold the battery cap back, opening the battery compartment (3.

25 © 2001 Nokia Mobile Phones.
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Nokia Music Player - Getting started

Insert the battery
Insert the plus + end of the battery first into the battery compartment.

Close the battery cap
Fold the battery cap down (D and
carefully press and slide the battery cap

back into place (2), closing the battery
compartment.

26 © 2001 Nokia Mobile Phones.
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Nokia Music Player - Getting started

Attach the headphone cable
R Plug the headphone cable in on the right side of the Nokia Music Player.
NOKIA ﬁ

Note: Always be careful when inserting or removing the
headphone cable. Grasp the cable by the thick portion
Inserting the memory card

| ——)

just above the metal plug. Never insert or remove the
cable by holding or pulling the cable portion itself.

A,

Open the memory-card cover
Grasp the end of the Nokia Music
Player and pull the memory-card
cover open from the notch.

27
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Nokia Music Player - Getting started

Insert the memory card
Turn the Nokia Music Player face down and hold the memory-card cover open. With the label
side of the memory card facing up, slide the card into the memory-card slot and push in. The
memory card locks into place.
Note: Before installing the memory card, always make sure that the Nokia Music
Player is switched off.

28 © 2001 Nokia Mobile Phones.
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Nokia Music Player - Getting started

Close the memory-card cover
Slide the tab of the memory-card cover into the memory-card compartment.
Note: If the memory card is not properly inserted all the way, you cannot close the
memory-card cover. Remove the memory card, see below, and insert it
again.

Removing the memory card

Open the memory-card cover
Grasp the end of the Nokia Music Player and slide the memory-card cover open.

29 © 2001 Nokia Mobile Phones.
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Nokia Music Player - Getting started

Remove the memory card
Press the memory card in (D). When the memory card is pushed all the way in it springs back
out . Pull the memory card out and remove it from the Nokia Music Player.
Note: Do not remove the memory card while the Nokia Music Player’s power is
on. This could result in loss of recorded music from the memory card and
damage the memory card.

30 © 2001 Nokia Mobile Phones.
All rights reserved.



Nokia Music Player - Getting started

How to wear your Nokia Music Player

Wearing your headphones

The left headphone is marked with an L. Put this headphone in your left ear. The longer
headphone cable is the right channel. Place the right channel cable behind your neck to your
right ear.

31 © 2001 Nokia Mobile Phones.
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Nokia Music Player - Getting started

Wearing your Nokia Music Player

Your Nokia Music Player has a clip on the back that can attach or hang the Nokia Music
Player to varying thicknesses of clothing. You can hang the music player from the top of a
pocket, on the collar of a suit, almost anywhere.

32 © 2001 Nokia Mobile Phones.
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Nokia Music Player - Getting started

Thread the headphone cable into the neckstrap
Thread the headphone cable through the Nokia-labeled cable holder
before plugging the headphone cable into your Nokia Music Player.

Attach the strap to the Nokia Music Player

! Loop the Nokia Music Player leather-like strap through the hook on
the back of the Nokia Music Player.

33 © 2001 Nokia Mobile Phones.
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Nokia Music Player - Getting started

Wearing the neck strap
Place the neck strap over your head and hang the Nokia Music Player.

Note: The headphone cable acts as your FM radio antenna. Use of the neck strap
prevents the headset cable from becoming tangled and improves FM radio
reception.

34 © 2001 Nokia Mobile Phones.
All rights reserved.



Connecting to your personal computer

Note: You must install Nokia Audio Manager or Nokia CD Manager before con-
necting your Nokia Music Player to your personal computer.

Remove the Phone/PC connector cap
Pull open the cap on the Phone/PC connector. The cap can be
removed from the Phone/PC connector but stays attached to your
Nokia Music Player.
Note:  To prevent dust, dirt or moisture from getting into the
Phone/PC connector on your Nokia Music Player
always replace the cap when not in use.

Phone/PC
connector

Connect your Nokia Music Player

Insert the USB cable into the Phone/PC connector, being careful to
line up the pins.

Note: Always be careful when inserting or removing the headphone cable. Grasp
the cable by the thick portion just above the metal plug. Never insert or
remove the cable by holding or pulling the cable portion itself.

35 © 2001 Nokia Mobile Phones.
All rights reserved.



Connecting to your personal computer

Connect a compatible personal computer
Insert the USB cable into the USB connector on a compatible personal computer. Refer to the
user manual you received with your personal computer for further details.
Note: When attaching the Nokia Music Player, please put the player in standby
mode. Slide the Audio/off switch to off then slide Audio/off to Audio again.
This is standby mode.

Note: Disconnect your Nokia Music Player from the personal computer and turn it
off if you do not plan to use it for an extended time.

Turn on the music player
Slide the audio/off switch to audio.
Note: If no memory card has been inserted or if the memory is not
inserted properly is displayed. If the memory card
't is blank is displayed.
If the player is not used for three minutes the unit will go to sleep
and the display goes blank. Press /D' to wake the player.

g opne  spow
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Nokia Audio Manager - Usage

Managing your music
With your Nokia Music Player connected to your personal computer and using the supplied
Nokia Audio Manager software you can:

Copy music from your personal CD library
You can copy the contents of your personal library of CDs and load them to memory cards for
use in the Nokia Music Player.

Get music from the Internet
You can download specially encoded music files from the Internet and load them to your
personal computer or memory card for playback.

Organize your music library
You can create playlists of your favorite music. These playlists can be loaded along with the
music to your Nokia Music Player. You can also create a library of different collections of
music.
Note: After installation an Internet connection is only necessary when retrieving
CD track titles from the Compact Disc DataBase on the Internet.
MP3 files created for your Nokia Music Player are encrypted and cannot be
played on other music players.
This product limits the content that can be downloaded to the device due to
copyright protection. See Nokia Audio Manager - File types.
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Nokia Audio Manager - Usage

Starting Nokia Audio Manager
Start Nokia Audio Manager
Select the Nokia Audio Manager icon from the start menu. The program loads and the
starting screen is displayed.

Eile  Miew Skins  Help

- =

read a cd club.nokia.com

make a playlist

———— al NOKIA |

Coseering Prore P2

tatal plsy time 0:00
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Nokia Audio Manager - Usage

Nokia Audio Manager attempts to make a connection to your Nokia Music Player. Looking for
hardware player displays on your computer screen.

Looking for hardware player.

If your Nokia music player is on and properly connected scrolls through the
Nokia Music Player display.
Note: While your Nokia Music Player is connected to your personal computer and
is displayed you will not be able to operate the controls on the
Nokia Music Player to listen to music.

If your Nokia Music Player is off or if the Phone/PC cable is not properly con-
nected, Unable to communicate with portable device is displayed on your
computer screen. Follow the displayed instructions and refer to Nokia Audio
Manager — Error messages in this manual.
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Nokia Audio Manager - Usage

PC operation shortcuts

Some commands and menu selections can be done by typing a key or a combination of keys
without moving the cursor. In this section those shortcuts are indicated by the command or
menu selection in bold type with an underline under the character that is the shortcut.

Select a menu
Press the ALT key and the shortcut key. If the menu to be opened is File, then press ALT and F
at the same time. The File menu will open.

udio Manager

File “iew Skine Help

Select an item from an open menu
Press the shortcut key. If the item from the opened Help menu is Help Topics, then press H.
Help Topics panel is displayed.

 Help

Help On !

Select a button
Press the shortcut key. If the button is Select Tracks From Database, then press T. The Select
Tracks From Database panel opens.

| Select Tracks From Database

40
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Nokia Audio Manager - Usage

Help — Where to go from here?

Follow these instructions carefully and while you are in Nokia Audio Manager if you have
any specific questions click the Help “?” button in the upper right-hand corner of any dialog
box to access the online help files and select the item in question. If you are not sure how to
complete any task, choose Help Topics from the Help menu, in the upper left, and search for
the task in question. The online help files provides detailed instructions for all the tasks you

can perform with Nokia Audio Manager including additional tasks not listed in this manual.
Note: It is recommended that you read the online Help file after installation.

ﬂelp u?n

Mokia Audio Mangges

GE= N
File Miew Skirs | Help
S— =
Help On Shift-F1

Get Updates Online...
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Step 1. Playback from a CD

Play a CD
Start Nokia Audio Manager

Insert CD
Follow instructions for inserting a CD that came with your personal computer.
Note: If the inserted CD does not have track titles recorded on the CD the following
alert box is displayed.

Press Yes. The Playlist information is downloaded from the CD Database on
the Internet and displayed on your screen.

You must be able to connect to the Internet to get Playlist information from the
CD Database.
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Step 1. Playback from a CD

Get tracks from CD
Click make a playlist, then click Get Tracks From CD.

If there are already tracks listed in the Playlist when you click Get Tracks From CD a dialog
box is displayed and asks if you want to Play this CD, Append to Playlist or Cancel. If you
click Play this CD the current tracks listed are replaced by the tracks from the CD. If you select
Append to Playlist, the tracks taken from the CD are added to the current tracks in the
Playlist.

Get Tracks From CO
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Step 1. Playback from a CD

Select a track

Select the track you wish to play by placing the cursor over the desired track and click. A
green box appears to the left of the selected track and the track is highlighted. Information
about the selected track is displayed in the right panel.

~=1of x|

4 ger
File View Skins Help

make a playlist copyto devices reada cd club.nokia.com

Select Iracks From Database | Select Playlists From Database | Get Tracks From ¢0 Il piC 1A, o
Coroenng Poons &
b | Type Title Artist i

Tile:

My Lave

Artist:  Various
Time: 359

File Size: 3782

Encoder: AAC

Bit Rate: 128000
Sample Rate: 44100

Source: compact disg Q
Original Album:  NOI usic Likrary
Original Track: 1

Categories:
Unfiled

2]
2]
2]
{2
(4]
o
2]
2]
2]
{2
(4]
o
2]
2]
{2

Don't pull outtl

17 tracks tatal play time 1:02:25

e s ek sspieet | Bt [ 8
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Step 1. Playback from a CD

Play the track
Press o . The selected track begins to play and the green box changes to a green arrow
showing that the track is playing. If available the current track name, length and artist scrolls
through the display at the bottom of the window.

Note: A sound card is required to hear the playback. See Specifications.

Select a different track
While a track is playing, select a different track and press o . Play of the newly selected
track begins.

Scan through a track
While a track is playing, place the cursor over the SCAN button, hold down the left mouse
button and you can slide the SCAN button to any point in the track to listen to it. Playback
continues even during scanning.

SCAN REPT SHUF

aiilll - Tf they call (04:04)4 | ESEHp ke

Repeat CD playback
Click REPT. The REPT indicator changes to green and after all tracks of the CD are played,
playback begins again with the first track. To cancel repeat playback click REPT again.

Random playback
Click SHUF. The SHUF indicator changes to green and the tracks of the CD are played back in
random order. To cancel random playback click SHUF again.
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Step 1. Playback from a CD A
Using the Small Player &

Switch to Small Player
Click @ , on the bottom right-hand side of the panel, to transform Nokia Audio Manager
into a Small Player.

00:00 rious - My Lowe (03:59)4

uoL comnnillllll pan canilin.
e, e,

SCAN Play SHUF REPT

In Small Player mode you can play the tracks in your current Playlist. To return to the Big
Player, right click on the Small Player and select Big Player.

v
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Step 2. How to read CDs

Adding tracks from CDs
In Nokia Audio Manager, you can record tracks from your audio CDs. The tracks are
recorded as digital audio files and stored on your hard disk.

Insert CD
Follow instructions for inserting a CD that came with your personal computer.
Note: If you insert CD while Nokia Audio Manager is open, tracks from the CD are
automatically added to the Playlist.
If the inserted CD does not have track titles recorded on the CD, the following
alert box is displayed.
: et.
he Internet

Press Yes. The Playlist information is downloaded from the CD Database on
the Internet and displayed on your screen.
You must be able to connect to the Internet to get Playlist information from the
CD Database.

Get tracks from CD

Click read a CD.
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Step 2. How to read CDs

Select a track
Click in the square box next to the track you wish to select. A check mark appears in the box.

Deselect a track
Click on a check mark next to the track you wish to deselect.

Select/Deselect

make a playlist copy to devices

Artist: Various
Time: 4:04

File Size: 3859 =
Encoder:  AAG _é-

BitRate: 128000 Y
Sample Rate: 44100

i compact disc i I}
jinal Album: ~ NOKIA Music Library ord
Original Track: 7 3 L
i~

Categories: =
unfiled

Select all tracks
Click Tag All.

6% of If they call

Deselect all tracks
Click Untag All.

Tag All  Untag All
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Step 2. How to read CDs

Start reading tracks

Click Start Reading. Nokia Audio Manager starts encoding and copying the selected tracks to
the hard disk. The status of the operation is shown in the progress bars in the bottom right of
the panel. After a track has been encoded and copied to the hard disk the check mark disap-
pears the type icon changes from a IE} toa @' When all selected tracks have been encoded
and copied to the hard disk Recording completed successfully! is displayed. Click OK. Nokia
Audio Manager has created a playlist in your database for this CD and links the new track
records to that playlist.

& oy =

read a cd club.nokia.com

NOKIA | =

CaveeminG Poore. B0

Start Reading
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Step 2. How to read CDs

Edit track info

On the read a c¢d window, click Edit Track Info. The Review Playlist panel appears and the
titles of the tracks is displayed. Select the track you wish to edit by clicking on it. Click
Review/Edit. Edit existing information or add information for each track. Press <<Prev or
Next>> to move to the previous track or to the next track. Press Close to save your changes
and close the window or press Cancel to discard your changes and close the window.
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Step. 3 Working with the database

Add tracks from the Internet
In the future you may be able to download digital audio files from the Internet. Nokia Audio

Manager can also detect these files as they are added to your hard disk and automatically
add them to your database.

Connect to the Internet
Click club.nokia.com. Nokia Audio Manager uses your Internet connection to connect to Club
Nokia.
Note: If this is your first visit to Club Nokia register. Click Join Club Nokia. Follow
the instructions to register.

If you do not have an
S nonesuort active Internet connec-
L e : : tion, do not click on the
link to go to
club.nokia.com. Your
computer may hang
causing you to restart
the computer.

ol (18)50% Various - The One
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Step. 3 Working with the database

View downloadable files

In the future Nokia Club may offer downloads (some of which may be free, some of which
may be purchased) from a variety of partners. Follow links to partners’ web sites for addi-
tional downloads. If you know the Web address of a specific site that you would like to visit,
type the address in the address field and click the Enter key on your keyboard. The controls
on this window (Back, Forward, Stop, and Home) work just like your Web browser.

Download files

Typically, to download a file from the Internet, you click the link for the file that you want to
download. Specify where you want to store the file on your hard disk and your bowser
download the file. Downloaded files are automatically added to your database. See the
documentation for your Web browser for more information on downloading files from the
Internet.
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Step. 3 Working with the database

Making a custom playlist

After your tracks are in the database you can select tracks to make custom playlists. Create a
playlist when you want to make party mixes or create playlists to send to your Nokia Music
Player. Add the tracks you want to the current playlist, organize the tracks in the order you
want, and save the list as a playlist.

Select tracks from the database

Click make a playlist then click Select Tracks From Database. Select Tracks From Database
window appears and shows a list of all tracks in your database, including the track title, artist,
playing time, rating, and genre. You can sort the list of tracks by clicking on any column
heading, for example click the Artist column heading to sort the list alphabetically by artist.

Title:

Your Phone
Artist:  Various
Time: 4:33

File Size: 4393
Encoder: AAC

Bit Rate: . 128000 |

M
M
M
M
M
M
M
LA
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Step. 3 Working with the database

Select tracks to add to the playlist

Click in the square box next to the track you wish to select. A check mark appears in the box
next to a selected track. You can also click Tag All to select all displayed tracks or Untag All to
deselect all tracks. When you have selected the tracks to be added click OK.

Save the custom playlist
Click Save Tracks as Playlist.

A7 of 17 tracks selected, Estimated space required; 59680 KB

5
gioonbist | (seveTrasksas piavist, | bl b [l iftizets e Fommat i ) b )

il Yarious - My Love (03:5

Save Tracks as Playlist
The Add Playlist window is displayed. Enter a name for your custom playlist and any addi-
tional information you wish to add either by entering the information or by clicking on the
drop-down menu boxes. When you have finished entering information, click Close to save
your custom playlist or Cancel to discard your changes and close the window. If you click
Close, The playllst has been saved is displayed. Click OK.

Cloge Cancel
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Step 4. Transferring music to your memory card

You can use Nokia Audio Manager to transfer tracks and playlists to your Nokia Music
Player.

Open the devices window
Click copy to devices.

copy to devices

read a cd club.nokia.com

Add tracks
Click Select Tracks From Database or Select Playlists From Database to select and add tracks
or playlists.

Select Tracks From Database  Select Playlists From Database

M zed  [(8alactad [T avaitahic Bl ovar
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Step 4. Transferring music to your memory card

Select tracks to transfer
Click in the square box next to the track or playlist you wish to select. To select all of the
tracks in the list, click the Tag All button. To deselect all the tracks that are currently selected,
click the Untag All button. After you have selected the tracks or playlists that you want to add
to your transfer list, click OK.
Tag All Untag All
il I It S

Categories:
Unfiled

A7 tsaged

Note: If the number of tracks or playlists exceeds the capacity of the memory card,
Not enough room panel appears. Follow the instructions on the panel to
deselect tracks or playlists until the capacity of the memory is no longer
exceeded.
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Step 4. Transferring music to your memory card

Copy selected tracks to the memory card

Click Copy to Portable. Converting file for download is displayed and then Sending to device
with a progress window. When the transfer is complete Finished transferring tracks is dis-
played. Click OK.

Copy to Portable
B

0 4 o =

make a playlist copy to déuites read acd lub.nokia.com

Remove tracks from the memory card
Remove tracks from the memory card by selecting a track and click i or right click on a
track and click on Remove. The track is erased from the memory card.
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Step 5. Backup music and restore

This feature to be offered in the future. Please access club.nokia.com for information.

58 © 2001 Nokia Mobile Phones.
All rights reserved.



Nokia CD Manager

The Nokia CD Manager allows you to copy music from an audio CD, rename the tracks, and
transfer the music to your Nokia Music Player. A connection to the Internet is not necessary
for the Nokia CD Manager.

Getting and listening to music overview
Using Nokia CD Manager you can quickly get and listen to your music.

Get music

4

Read a CD

J

Rename tracks

J

Copy to
Nokia Music Player

g

Listen to music
See Memory card playback
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Nokia CD Manager - Help

Help — Where to go from here?

Follow these instructions carefully and while you are in Nokia CD Manager if you have any
specific questions right-click on the face of the application window and select Help to access
the online help files and select the item in question. The online help files provides detailed
instructions for all the tasks you can perform with Nokia CD Manager including additional

tasks not listed in this manual.
Note:

It is recommended that you read the online Help file after installation.

£? Nokia CD Manager Help. =lolx|
=

Hide Back Foward Finl

Contents | Index | Search| |

Introduction

& Using Nokia CD Manager
% Right-click options
" Eror Messages

The MNokia CD Manager will allow you
to copy music fram an audio CD,
rename the tracks, and transfer the
music to your MNokia Music Player

A connection ta the Internet is not
necessary for the Mokia CD

Manager.
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Nokia CD Manager - Help

e E

3 1o
= &

Back Fomward  Print

Hide

Corterds | inder | Seach] Introduction =
[] Intraduction o
(VB Ui o

el The Nokia CD Manager will allow you
g e music -~ avervie to copy music from an audio CO,
rename the tracks, and transfer the
music to your Nokia Music Player.

A connection to the Internet is not
Copy ta Mokia Music Playsr necessary for the Nokia CD

[7] Listen to Music Manager

& Right-click options
% Eror Messages

7] Gt music
2 ReadatD
i [2] Rename Track

1|

]
First double click on any book icon in the left panel to open the help item list. Then click on
any topic for the help information to be displayed in the right panel.
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Nokia CD Manager - Help

E? Nokia CD Manager Help =lol x|

Hide  Back Forward Print

Lontents Ilgdex I gaarchl Get music
Introduction
3 Using Nokia CD Manager Launch the Mokia CD Manager from your
[2] Getting and listeriing ta music ~ avervie computer. The following screen will appear.
- [7] Get music
9] Read a LD
(7] Rename Track
- @ Copy to Nokia Music Player
- 9] Listen to Music
Q Right-click options
Q Errar Meszages

ReadaCD...

The ﬁ buttan

begins the CD read operation

p—
S || | .

Click on any button displayed in the right panel and a pop-up information box is displayed.
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Nokia CD Manager

Step 1. Get music
Select the Nokia CD Manager icon from the start menu. The following screen will appear:

{f Mokia CD Manager

Nokia CD Manager

tedia On Device

Media On PC

Fieady.

Any audio files existing on your computer are listed on the left; any audio files existing on
your personal device are listed on the right. If your device is not currently connected to your
computer, the column on the right will reflect this.
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Nokia CD Manager

Step 2. Read a CD
“Read a CD” refers to the process of copying the tracks from your CD-ROM to the hard disk
drive of your computer. To read a CD, simply place an audio CD disk in the appropriate drive,
and start Nokia CD Manager. Choose consecutive files by using the shift key; choose noncon-
secutive files by using the control key.

Click the [IRFEE&ET button to launch the CD Transfer dialog. The Progress Control bar will
show the progress of the operation.

Read CD T‘“‘

NOKIA Nokia CD Manager

Select tracks to read CO Diive |E: i

Track_01
Track_02

Track_0E
Track_07
T Lo

Track_11
Track_12
Track_13
Track_14

Feady...

(| e
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Nokia CD Manager

Step 3. Rename tracks
Right-click on a single file name in the Track List Box. The Edit Box will display the name of
the currently selected file name.

OigNeme  [REEREET

Mew hame IHappy Birthday |

[ el

Type in the name that you choose. The name must be unique; another track with the same
name cannot exist on your computer or your Nokia Music Player.

Note: Do not use any of the following characters in the name: /\:*?"<>!@]|
Click the Rename to complete the operation.
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Nokia CD Manager

Step 4. Copy to player and listen to music
On the left side of the screen, highlight the media files to transfer to the Nokia Music Player.
You can use the shift key to highlight consecutive files, or the control key to highlight non-
consecutive files.
Click the [E¥E35 ] button to copy the files to the Nokia Music Player.
See Nokia Music Player — Memory card playback.
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Nokia CD Manager A
Step 5. Using menus &

Media On PC-Right click
Right-clicking any item in the list of the Media On PC box will bring up the following menu:

Change PC Directory

The Audio Manager by default saves your media files to the C: drive of your computer. To
change the directory, right-click on the face of the Nokia CD Manager and choose Change PC
Directory...

Refresh Device
Refresh the Media On PC or Media On Device list box.

Format Device
To format the memory card in your Nokia Music Player, right-click on the face of the Nokia
CD Manager and choose Format Device...
Note: All music on the memory card of the Nokia Music Player will be lost when
the device is formatted!

v
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Nokia CD Manager

Read a CD

Nokia CD Manager starts reading from your audio CD.

Remove
Right-click on the name of the file to remove.

Rename
Right-click on the name of the file to rename the file.

Help
The Help option will access an on-screen help file.

Close
Close closes Nokia CD Manager.
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Nokia CD Manager A

Media On Device-Right click &
Clicking on a single file in the Media On Device window will bring up the following Menu:

Change PC Directory

The Nokia CD Manager by default saves your media files to the C: drive of your computer.
To change the directory, right-click on the face of the Nokia CD Manager and choose Change
PC Directory...

Refresh Device
Refresh the Media On PC or Media On Device list box.

Format Device
To format the memory card in your Nokia Music Player, right-click on the face of the Nokia
CD Manager and choose Format Device...
Note: All music on the memory card of the Nokia Music Player will be lost when
the device is formatted!
Read a CD
Nokia CD Manager starts reading from your audio CD. '
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Nokia CD Manager

Rename._track

You cannot rename a track from the Media On Device link box.

Remove
Right-click on the name of the file to remove.

Help
The Help option will access an on-screen help file.

Close
Close closes Nokia CD Manager.
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Nokia CD Manager

Step 6. Backup music and restore
This feature to be offered in the future. Please access club.nokia.com for information.
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Nokia Music Player - Memory card playback

Memory card playback controls

This section explains in detail the controls you use to listen to music from a memory card.
To copy music to the memory card see Transferring music to your memory card (with Nokia
Audio Manager) or Copy to player and listen to music (with Nokia CD Manager).

Turn on the music player
Slide the audio/off switch to audio.
Note:  If no memory card has been inserted or if the memory card is
not inserted properly is displayed. If the memory
t card is blank is displayed.

Select playback from the memory card
If the music player was last used for playback from the memory card the
display shows:

[ MusicOn 58] [ V100 =] Digital 3=
If the music player was last used for playback from the FM radio the display shows:
[ MusicOn3&] [ V100 %[ M 38

Note: The Nokia Music Player is shipped with Firmware Version 1.00. See
Upgrade — Nokia Music Player for instructions on how and when to upgrade
the firmware (to be used for special feature upgrades in the future).

g olpne  spow N\
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Nokia Music Player - Memory card playback

mode

Note:

To switch from FM radio playback to memory card playback press and hold
the mode key for several seconds until is displayed and then the
playlist name.

Note: If no playlist name has been recorded to the memory
card is displayed.

Adjust volume
Press the volume button up + or down - to adjust the volume.

5 &
Minimum T - Mz
N

3
EIII':I' { !____ P MHz
N

fom]
I ;=

Maximum

The volume level is remembered by the Nokia Music Player. When playback
resumes the volume returns to the last setting.
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Nokia Music Player - Memory card playback

Play a track
Press /0. The first track on the memory card begins to play, the track title scrolls for 30
seconds then the playtime is displayed.

Blinks during playback

| Musict l'tt »
[xIa Nt
[N (")

Pause playback
While a track is playing, press 2/ and playback pauses and the playtime and music notes
blink.

|E-'E-':'02:15 4;}1::]

Note: If you leave the player in the pause mode for three minutes the player
automatically enters a power-saving sleep mode.

Resume playback
While a track paused, press /D and playback resumes.
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Nokia Music Player - Memory card playback

Stop playback/turn off
Slide the audio/off switch to off.

3 Selecting a track to play

‘ Move forward a track
While a track is playing or paused, press > with one quick press. Each time
you press 3> playback moves to the next track and the track number changes

in the display.
i)
i

Move back to the beginning of a track
After a track has played over two seconds, press €€ with one quick press. Playback returns
to the beginning of the track.

g opne  spow

Fo)

(S

Move back a track
After a track has played over two seconds, press €€ with two quick presses. Playback moves
to the track previous to the playing track and the track number changes in the display.

Fom)

i N
(]
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Nokia Music Player - Memory card playback

Scanning tracks
You can move forward or backward through a track quickly.

Scan forward in a track

While a track is playing or paused, press and hold >. When you press and hold >, the
player scans forward through the track and playback is muted while the playtime count
increases. When you release 2, playback begins again.

|E-'E-'E’ 02:%: J;;c:l

Scan backwards in a track

While a track is playing or paused, press and hold €€. When you press and hold €¢, the
player scans backwards through the track while the playtime count decreases. When you
release €€, playback begins again.

| ooe 03:?'2@ 5 Fm] |

3

Selecting playback options

Play all tracks once
Press mode. is displayed. Within several seconds, press €€ or »> repeatedly

until is displayed.
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Nokia Music Player - Memory card playback
/Cs Repeat play of all tracks

Press mode. is displayed. Within several seconds, press
€C or DD repeatedly until is displayed.

Repeat play of one track
While listening to the track that you want to repeat, press mode.
is displayed. Within several seconds, press €€Cor >>

repeatedly until is displayed.

Play all tracks in random order
Press mode. is displayed. Within several seconds, press
€C or DD repeatedly until is displayed.

mode
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Nokia Music Player - Memory card playback

Selecting playback tone

There are five different tone settings to enhance playback of your music. The five settings
are; Normal, Classic, Rock, Jazz, or Custom. In the Custom setting you can adjust Bass and
Treble. For maximum enjoyment of your recorded music select the tone setting that most

closely matches the type of music you are listening to.

mode

.
|

Select a tone setting

While a track is playing or paused, press mode twice. is
displayed. Within several seconds, press €€ or > repeatedly to
select the tone setting you wish to use; [m:Nomal 5%], (g Classic 5%,
[siRock  3™=], [miJam 3], OT [m:Custom ™. The selected tone setting is
applied to your music.

Select Custom tone setting

While a track is playing or paused, press mode twice. is
displayed. Within several seconds, press €€ or > repeatedly to
select [g:Cusom 3] . Within several seconds, press mode again. The
display changes to [m:Treble 5%=] or [m:Bass  5=]. Within several
seconds, press €€ or > repeatedly to select between
Or [miBass  3%].
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Nokia Music Player - Memory card playback

mode (2x) j

oo Nomal 3
oo ¢ Classic
oot Rock 3

!

/ -
mode

]

oo Treble 3= mode
o0 Bass e mode

Adjust Bass and Treble
While [gg:Treble 5= Or [g:Bass 3= is displayed press the mode and then the
volume button up + or down - to adjust Bass or Treble.

Bass |5'E BN »J}E-El
treble oo TIN5
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Nokia Music Player - Memory card playback
Button lock

This locks the buttons on your Nokia Music Player to prevent the buttons from being acci-
dentally pressed (for example, when your Nokia Music Player is in your pocket).

Lock the buttons
After adjusting your Nokia Music Player as you like it slide hold in
J the direction of the arrow. is displayed. All buttons are
w locked.
h Old = 1@. t Note:  You can still answer the phone and make phone calls
g
£

while connected to a Nokia mobile phone by
pressing 2.

If you place the Nokia Music Player in the sleep mode

and then lock the buttons you can still resume playback
by pressing /0.

Unlock the buttons

If you want to unlock the buttons slide hold in the direction of the
arrow. The buttons are unlocked.

)

hold é

\\

hold —>

+ volume -
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Nokia Music Player - Memory card playback

Display lighting

The display lights for several seconds whenever you press any of the keys on the Nokia
Music Player. If you want to turn the display light on press and hold /0. The display
lights. When you release /D the display light goes out.

Press and hold
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Nokia Music Player - Tuning in your FM radio

Your Nokia Music Player also receives FM stereo radio broadcasts. Before you can listen to
FM broadcasts you must insert a battery into your Nokia Music Player and attach the head-
phone cable. If you have not done these yet please see Nokia Music Player — Getting started.

I olpne  apow \

The headphone cable is the antenna for your FM radio. If you wish to attach
and use a different headphone cable make sure it is the same length as the
original headphone cable.

Turn on the music player
Slide the audio/off switch to audio.

Select playback from the FM radio
If the music player was last used for playback from the FM radio the display
shows:

[ MusicOn3&] [ V100 0] [ M 5%

If the music player was last used for playback from the memory card the
display shows:

[ MusicOn 3&] [ V100 33| [ Digtal 3=
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Nokia Music Player - Tuning in your FM radio

To switch from memory card playback to FM radio playback press and
hold the mode key for several seconds until is displayed.
The frequency of the last selected FM radio station is then displayed. If

the frequency selected is a broadcasting FM station you will hear the
broadcast.

0

mode

B opne <|ow

[ %9 5=

Adjust volume
Press the volume button up + or down - to adjust the volume.
Fr o 3 &
Minimum U memme M
»
El‘ﬂ { !____ J}‘mz
» &
[l‘[l' { !l____ J}‘mz
I ;=
Maximum mmmm=
Note: The volume level is remembered by the Nokia Music Player. When playback

resumes the volume returns to the last setting.
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Nokia Music Player - Tuning in your FM radio

Selecting a frequency

Select a higher frequency
Press 2> with one quick press. The frequency selected increases by 100 Hz and is displayed.
Press > repeatedly with quick presses until the desired frequency is tuned in.

| FM100.05%| =mp | FM100.1 %%

Select a lower frequency
Press €€ with one quick press. The frequency selected decreases by 100 Hz and is displayed.
Press €C repeatedly with quick presses until the desired frequency is tuned in.

| FM100.1 4% = | FM100.0 }ur
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Nokia Music Player - Tuning in your FM radio

Using FM frequency auto-search
You can use the Nokia Music Player to automatically search for a FM stereo broadcast of
sufficient strength for good reception.

Auto-search for a higher frequency

Press and hold 2>. The frequency displayed changes as auto-search begins. Release 3. The
Nokia Music Player automatically searches up the frequencies until a stereo broadcast of
sufficient strength for good reception is found while increasing the frequency displayed.
When a suitable station is found the frequency display stops changing.

S

Auto-search for a lower frequency

Press and hold €. The frequency displayed changes as auto-search begins. Release €C. The
Nokia Music Player automatically searches down the frequencies until a stereo broadcast of
sufficient strength for good reception is found while decreasing the frequency displayed.
When a suitable station is found the frequency display stops changing.

[ M=
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Nokia Music Player - Tuning in your FM radio

Using station presets

You can set up to five of your favorite FM stations for easy recall.

mode

.p

Select a frequency
When you have tuned in a station press mode twice. is

displayed and after two seconds is displayed.

Assign a recall channel
While is displayed, press €€ or > to assign a recall
channel of CH1 to CH5.

[cwiSelect 52| mb [aSelect 5=

After you select a recall channel of CH1 to CH5 press mode.
is displayed. Your selected frequency has been stored.
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Nokia Music Player - Tuning in your FM radio

Recall a preset frequency
Press /0. With each press of /D the recall channels are displayed with the frequencies
that have been stored in memory.

ri FM 991 5.0 w |2 FM 100.0 4.0

The recall channel and frequency you want to listen to is displayed. After two seconds you
hear the selected frequency.

Switching stereo and monaural
Sometimes radio interference or a weak signal can cause your reception to become noisy.
Switching to monaural may help to cancel the noise.

Select monaural
While listening to the radio, press mode with one quick press. The present stereo or monaural
status is displayed. Press €€ or 22 to display [ Moo 3®]. Playback becomes monaural.

Select stereo
While listening to the radio, press mode with one quick press. The present stereo or monaural
status is displayed. Press €€ or 2> to display [ Sero 5=]. Playback becomes stereo.
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Nokia Music Player - Using as a hands-free headset

When connected to your Nokia mobile phone the Nokia Music Player allows Hands-free
Switching. You can listen to music and when there is an incoming call you can answer the
phone and speak to the caller without touching the mobile phone. You can also dial out
without touching your mobile phone by using voice dialing.

Note: Voice dialing is available when using Nokia 3310, 3330, 8250 and 8890
mobile phones.

What phones can be used?
These Nokia mobile phones have been designed to work with your Nokia Music Player. Do
not attempt to connect your Nokia Music Player to other phones.

Nokia 8210 Nokia 3310, 3330 Nokia 8850, 8890 Nokia 8250
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Nokia Music Player - Using as a hands-free headset

Connecting your Nokia Music Player and phone

. Remove the Phone/PC connector cap
o Pry off the cap on the Phone/PC connector. The cap can be
removed from the Phone/PC connector but stays attached to your

Nokia Music Player.
Phone/PC . . .
connector Note: The cap is attached to your Nokia Music Player.
- 1

Do not attempt to remove it.

To prevent dust, dirt or moisture from getting into the
Phone/PC connector on your Nokia Music Player
always replace the cap when not in use.

Connect your Nokia Music Player
Insert the phone cable into the Phone/PC connector, being careful
to line up the pins.

Note: Always be careful when inserting or removing the
cable. Grasp the cable by the thick portion just
above the metal plug. Never insert or remove the
cable by holding the cable portion itself.
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Nokia Music Player - Using as a hands-free headset

Connect your Nokia mobile phone
Insert the phone cable into the connector on your Nokia mobile phone. The connector’s
position is slightly different depending on which model phone you have.

R

Nokia 8210

Nokia 8850, 8890 Nokia 8250
* Note: Be careful not to scratch the phone cable connector when opening or
closing the sliding cover of the phone.
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Nokia Music Player - Using as a hands-free headset

Receiving and making calls

With the Nokia Music Player and Nokia mobile phone are connected you can receive and
place calls with Hands-free Switching. Listen to your favorite music and when a call comes
in the phone rings through your headphones and the music is muted, or when you place a
call the Nokia Music Player automatically mutes the music. Also, your Nokia Music Player is
equipped with a microphone so you can speak without touching the phone.

Note:

Voice dialing is available when using Nokia 3310,
3330, 8250 and 8890 mobile phones.

If the microphone of the Nokia Music Player is too far
from your mouth the microphone may pick up
unwanted surrounding noise. For optimal voice pickup
place the Nokia Music Player within about 15 cm of
your mouth.

If your Nokia Music Player is off you can still place or
receive calls through your Nokia mobile phone but
sound only comes through the left headphone.

If the battery is exhausted or if there is no battery the
Nokia Music Player must be off so you can place or
receive calls.
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Nokia Music Player - Using as a hands-free headset

Receiving a call

Receive a call

If your phone rings while you are listening to music a ringing tone sounds in your headphone.
is displayed. Press 2 for a second. The music is muted and if you are listening to
music from a memory card, playback pauses. Begin speaking in a normal voice. You will hear
the caller’s voice in the headphone.

End call
When you have completed your call simply press 2 once again for one second. The phone
call is disconnected and playback resumes.
Note: To maximize listening time from a battery turn off the Nokia Music Player
when not listening to music. You will still be able to hear and talk through
the headphone when the music player is off.

Placing a call

Even with your Nokia mobile phone in your pocket you can dial out very easily. Using both
Hands-free Switching and voice dialing you can make a call without touching your Nokia
mobile phone. Refer to the manual that you received with your Nokia mobile phone for

more information on voice dialing.
Note: Voice dialing with the Nokia Music Player is supported for Nokia 3310 and
8890 mobile phones.
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Nokia Music Player - Using as a hands-free headset

Activate your phone
Press and hold 2 for a second. The music is muted and if you are listening to music from a
memory card, playback pauses. You will hear the voice starting tone through the headphone.

is displayed.

Voice dial
Speak the name of one of the numbers already recorded in your Nokia mobile phone. The
recognized name plays back through the headphone and after a short wait the registered
phone number is dialed. Speak in a normal voice when your party answers.
Note: If the phone fails to recognize the name, an error tone plays through the
headphone. Start again from Activate your phone above.

Refer to your phone’s users guide for important information about voice dialing.
End call

When you have completed your call simply press ? once again. The phone call is discon-
nected and playback resumes.
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Nokia Music Player - Hands-free Switching

There are different ways you can possibly answer and end calls when connected to a Nokia
mobile phone. Below are explanations of the different methods. Please refer to the user
manual that you received with your Nokia mobile phone for specific instructions on using

your phone.

Receiving calls

Receive a call

End a call

Result

Press 3

Press 7

This is the recommended way of using Hands-free
Switching. When you press 9 to receive the call, the music
is muted and if the music is being played back from the
memory card playback pauses.

Press End

&'@

When you press the 2 to receive the call, the music is
muted and if the music is being played back from the
memory card the playback pauses. When you press End the
call is ended and within five to ten seconds playback begins
again, starting at a low volume and increases until it reaches
the volume setting at the beginning of the call.

Press Answer

N

Press 3

When you press Answer you will hear the voice of the caller
but playback of the music continues, mixed with the caller’s
voice. This is called Music Call. When you press 2 the call
is ended and the music continues.

Press Answer

e

Press End

&'@'

When you press Answer you will hear the voice of the caller
but playback of the music continues, mixed with the caller’s
voice. This is called Music Call. When you press End the call
is ended and the music continues.
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Nokia Music Player - Hands-free Switching

Placing calls

Place a call

Result

Press Call

B

When you press Call your phone dials and connects to the
caller but playback of the music continues, mixed with the
caller’s voice. This is called Music Call. When you press
End, the call is ended and the music continues.

Press Call

B

When you press Call your phone dials and connects to the
caller but playback of the music continues, mixed with the
caller’s voice. This is called Music Call. When you press ?
the call is ended and the music stops. Press 2 once again to
begin listening to music.

Receiving SMS

Result

Press Read

i

The selected SMS arrival tone is played through the
headphones. Operate your Nokia mobile phone normally to
receive and display a SMS.

Sending SMS

Result

Press Send
)

Operate your Nokia mobile telephone normally to compose
and send a SMS but no sound from key presses are heard
through the headphones.
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Nokia Music Player - Hands-free Switching

Voice dialing

Voice dial Ending a call

Result

Press 2 and hold Press 7

!

g =

Press and hold 2 for several seconds. The music is muted
and if you are listening to music from a memory card,
playback pauses. You will hear the voice starting tone

through the headphone. is displayed.

Speak the name of one of the numbers already recorded in
your Nokia mobile phone. The recognized name plays back
through the headphone and after a short wait the registered
phone number is dialed. Speak in a normal voice when your
party answers.

When you have completed your call simply press 2 once
again. The phone call is disconnected and playback
resumes.

Activate voice dialing Press End

A ‘e B

You must turn off your Nokia Music Player before voice
dialing. Refer to your Nokia mobile phone user manual.
When the call is over you can turn Nokia Music Player on
again.

Other Nokia mobile phones that support voice dialing

Voice dial Ending a call

Result

Activate voice dialing Press End

e 5

You must turn off your Nokia Music Player before voice
dialing. Refer to your Nokia mobile phone user manual.
When the call is over you can turn Nokia Music Player on
again.
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Nokia Music Player - Hands-free Switching

Volume settings and Music Call

Volume settings of the Nokia mobile phone and Nokia Music Player

When you answer or make a call with Music Call the volume of the voice on the phone is
mixed with the music at the volume that has been set on the Nokia mobile phone. If you use
the volume control of the Nokia Music Player to adjust the volume during the call, both the
volume of the music and the caller’s voice are adjusted simultaneously. If it is difficult to hear
the caller’s voice:

1. Lower the volume by using the controls on the Nokia Music Player.

2. Make the caller’s voice louder by using the volume control on the Nokia mobile phone.
We recommend that you set the volume on your Nokia mobile phone low. Then, when a call
comes in you can turn down the volume on your Nokia Music Player. Both the volume of the

Nokia Music Player and the Nokia mobile phone are decreased. Then turn up the volume of
your Nokia mobile phone, thereby raising only the volume of the caller’s voice.
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Nokia Music Player - Battery

While your Nokia Music Player is on the battery power indicator in the display shows you the
present strength of the battery.

2 &
| 3%

When the battery is at full power, five power bars show. As the battery weakens fewer and
fewer power bars show.

fui] = ] = 9] = ]

When the battery power indicator shows no power bars, you have approximately five min-
utes of power left. When the battery is completely exhausted LOW BATTERY displays and the
Nokia Music Player turns off. Until the battery is replaced the Nokia Music Player cannot be
turned on. To replace the battery see Installing the battery.

[ LOW | mp | BATTERY |
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Nokia Music Player - Battery

Power-saving tips

Under normal operating conditions, one Alkaline AAA battery supplies enough power to
play music from the memory card for approximately five hours.

When operated in a cold climate the battery life is considerably shorter and may supply
enough power to play music from the memory card for only several hours. Keep the player
covered and in a warm place.

Leaving a battery in hot or cold places, such as in a closed car in summer or winter,
reduces the capacity and lifetime of the battery. Always try to keep the battery between
15°C and 25°C (59°F and 77°F). If you use a overly hot or cold battery with your Nokia
Music Player it may temporarily not work even if the battery has been fully charged.

Although you can listen to music while talking on your connected Nokia mobile phone, it is
a good idea to conserve the battery’s power by turning the Nokia Music Player off for
longer phone conversations. See Hands-Free Switching.

Always select good quality, well known brand batteries for your Nokia Music Player.

Alkaline batteries are recommended for long life. NiMH is also usable. Do not use batteries
identified as Ni-Cad, manganese or manganese dioxide or lithium batteries.
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Nokia Audio Manager - Error messages

Question: I get an error message when I try to read a CD. What does this mean?

This indicates that there has been an error copying data from your CD-ROM
drive. Let Nokia Audio Manager select the best settings for you by clicking the
Configure it for me button in menu item View > Options> ReadCD tab.

Answer:

Question:

Answer:

Question:

Answer:

When I first start up Nokia Audio Manager, I get a message saying, “Some of this
program'’s file types are no longer associated with it.” What does this mean? Why
does it keep happening?

Nokia Audio Manager supports a number for different file types. You can choose
to have different file types automatically open and run in Nokia Audio Manager.
Go to menu item View > Options > File Types tab and put a check mark beside
the files you want to run in Nokia Audio Manager.

If you keep getting this message, it may be that there is another application on
your machine that is taking over the association of these files when you exit the
Nokia Audio Manager.

When I click copy to devices, I receive the message Unable to communicate with
portable device. What do I do?
There are several things to check if you get this message:

Check that the battery in your Nokia Music Player is not exhausted. See Battery.

Make sure your Nokia Music Player is connected properly with the supplied cable and turned
on. See Connecting to your personal computer.

On your computer desktop, check My Computer > Control Panel > System > Device Manager
> Universal Serial Bus Controller to see if your Nokia Music Player is listed. The listed name
is Nokia Music Player HDR-1 Nokia Mobile Phones Ltd. Click on the device listed and check
its Device Status. The status should read Working Properly. If it is not listed, slide the
audio/off switch to off and then back to audio and/or restart your personal computer.
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Nokia Audio Manager - File types

Playable file types with Nokia Audio Manager
These are some of the file types that can be supported with the Nokia Audio Manager depend-
ing on the software plugins available. Please note that only some of the file formats can be
used on the Nokia Music Player.

721 G.721 Audio Files .mov § Quicktime Movie
.asf * MS Media Playlist .pls PLS Playlist
.asx * MS Media Playlist rat RealAudio Files
.avi * Microsoft Movie .ram t RealAudio Streams
.bmr Universal Music Group .saf § DigiBox Audio Files
Reference Files .sm3 Secure Audio Files
.bmo Universal Music Group Offer .smil RA SMIL Files
Files .wav Wave Audio files
.bmt Universal .Music Group wax * MS Media Playlist
Content.F 11e§ -wm * MS Media Playlist
.cda CD Audio Files — .wma Microsoft Windows Media
JIse Nokia LSE DRM &&= Audio Files
.mp3 MPEG Audio Files wmv *  MS Media Playlist
-mpg MS Movie File wmx *  MS Media Playlist
-m3u Playlist File Wwvx *  MS Media Playlist

*  Must have Windows Media Player installed to view.
Must have Real Player installed to view.

Must have InterRights Point installed.

Must have QuickTime installed to view.

@ Files that can be downloaded to Nokia Music Player.

wn ++ —+
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Nokia CD Manager - Error messages

Question: Why did the Cancel Button error message display?

Answer: This message appears when you click the x| button in the title bar of the pro-
gram while reading a CD. To protect the CD reader, please use the __ Cancsl
button instead.

Question: Why when I try to copy, rename or read a file does Could not copy file error
message display?

Answer: The most likely reason that a file cannot be copied, renamed, or read is because it
is already in use. If you have another music device open on your computer, close
the device before continuing.

A file also cannot be copied, renamed, or read because it is not an audio file, or
because it is an written in a format that is incompatible with the Nokia Music
Player.

Question: What does the Device not attached error message mean?

Answer: The Nokia CD Manager is unable to detect your device. Check the following:

e [s your device connected to the computer? See Connecting to your personal computer.
e s the USB cable firmly inserted into both the device and the computer?

Question: What does the Free Space error message mean?

Answer: There is not enough free space left on the memory card of the Nokia Music Player
to complete the operation. Use Delete Tracks option of the Media on Device
window to delete files from the memory card in your Nokia Music Player.

Question: What does the Load an audio CD error message mean?

Answer: Please load an audio CD into your CD-ROM drive and try again. The Nokia CD
Manager cannot detect a CD in your CD-ROM drive. Check the following:

e [s the CD in your disk drive an audio CD?
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Nokia CD Manager - Error messages

e [s the CD-ROM drive closed?
e Is the CD-ROM drive in use?
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Nokia Music Player - Error messages

Question: Unsupported Audio is displayed on my Nokia Music Player.

Answer: You are attempting to play a file format that is not supported by the Nokia Music
Player such as; WMA. image or other unsupported format.

Question: Unusable Media is displayed on my Nokia Music Player.

Answer: The memory card in your Nokia Music Player is not supported. Replace with the
originally supplied memory card or other supported memory card. See Memory
card.

Question: Unknown Format is displayed on my Nokia Music Player.

Answer: Information on the memory card has been recorded in an unsupported file
format. Music cannot be played. Reformat the memory card with Nokia Audio
Manager in order to use with Nokia Music Player.

Question: Read Error is displayed on my Nokia Music Player.

Answer: The memory card may be defective or the power supplied may be uneven.
Replace the batteries with new ones. If Read Error displays again discard the
memory card and replace it with a new one.

Question: Data Error is displayed on my Nokia Music Player.

Answer: The selected track is corrupt and cannot be played. Press €€Cor 2> to move to a
different track.

Question: DRM Error is displayed on my Nokia Music Player.

Answer: There is a problem with the Digital Rights Management of the selected track and
it cannot be played. Press €€or 2> to move to a different track.

Question: No Media is displayed on my Nokia Music Player.

Answer: A memory card is not inserted or has been improperly inserted. Insert a memory
card or check that it has been inserted properly. See Inserting the memory card.
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Nokia Music Player - Error messages

Question: Format Error is displayed on my Nokia Music Player.

Answer: This error might be displayed while formatting a memory card with Nokia Audio
Manager. Try formatting the memory card again with Nokia Audio Manager.
When Format Error is no longer displayed the error has been corrected.

Question: No Track is displayed on my Nokia Music Player.

Answer: No music tracks have been recorded to the memory card. Copy music tracks
using Nokia Audio Manager or CD Manager. See Transferring music to your
memory card (with Nokia Audio Manager) or Copy to player and listen to music
(with Nokia CD Manager).

Question: Connect Error is displayed on my Nokia Music Player.

Answer: The Nokia Music Player is not properly connected to the PC with the USB cable
or the memory card has been ejected while the Nokia Music Player is connected
to the PC. Reinsert the memory card. See Inserting the memory card. Turn off
and reconnect your Nokia Music Player to the PC. See Connecting to your
personal computer.
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Nokia Music Player - Troubleshooting

Problem

Possible cause

Solution

The Nokia Music Player
does not work.

Hold is on.

Memory card is not
properly inserted.

The battery is dead.

Connected to the com-
puter.

Turn Hold off.

Check memory card.

Replace battery.

Disconnect from the
computer.

I cannot hear anything.

Volume is set too low.

Headphone cable is not
inserted properly.

Plug is dirty.

Adjust volume.

Check connection.

Clean and reinsert.

I hear noise.

Headphone or Phone/PC
cable is wrapped around
the player.

Uncoil cable from around
the player.
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Nokia Music Player - Troubleshooting

Problem

Possible cause

Solution

My caller can’t hear my
voice.

Microphone is too far
from your mouth.

Background noise is too
loud.

Place microphone within
15 cm of your mouth.

Go to a quieter area.

“Can't find a portable
device” message
appeared.

Memory card is not
properly inserted.

Nokia Music Player is not
on.

USB cable is not properly
connected.

Insert memory card
correctly.

Turn on player.

Check connection.

I cannot close the
memory card cover.

Music stops,
display freezes or
keys don’t work.

Memory card is not
properly inserted.

Memory card is not the
right kind.

Firmware error.

Insert memory card
correctly.

Make sure the memory
card is the same size as
the original memory card.

Remove and reinsert
batteries.
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Nokia Music Player - Troubleshooting

Problem

Possible cause

Solution

Voice dialing does not
work

Your phone does not
support voice dialing
when connected to the
Nokia Music Player.

Your Nokia mobile phone
is not properly set for
voice dialing.

Your Nokia Music Player
is not properly connected
to your Nokia mobile
phone.

Voice dialing is supported
only for Nokia 3310 and
8890 mobile phones.

Refer to the instructions
that came with your
Nokia mobile phone.

Check connection.
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Care and maintenance

Nokia Music Player

Your Nokia Music Player is a product of superior
design and craftsmanship and should be treated with
care. The suggestions below will help you to fulfill
any warranty obligations and to enjoy this product
for many years. When using your Nokia Music
Player:

Keep it and all parts out of the reach of small
children.

Keep it dry. Precipitation, humidity and liquids
contain minerals that corrode electronic circuits.
Do not use or store in dusty, dirty areas. Moving
parts can be damaged.

Do not store in hot areas. High temperatures can
shorten the life of electronic devices, damage
batteries, and warp or melt certain plastics.

Do not store in cold areas. When the music player
warms up (to its normal temperature), moisture
can form inside the player, which may damage
electronic circuit boards.

Do not attempt to open. Non-expert handling of
the device may damage it.

Do not drop, knock or shake it. Rough handling
can break internal circuit boards.

Do not use harsh chemicals, cleaning solvents, or
strong detergents to clean it. Wipe it with a soft
cloth slightly dampened in a mild soap-and-water
solution.

Do not paint it. Paint can clog the device’s moving
parts and prevent proper operation.

e Use only supplied cables and attachments.

Unauthorized modification or attachments could
damage the music player or result in less than
satisfactory performance.

If your Nokia Music Player, any parts or acces-
sories do not work properly, take them to your
nearest qualified service facility. The personnel
there will assist you and, if necessary, arrange for
service.

Memory card
e When buying a new MMC (Multimedia Card)

card, affix the accompanying label to the specified
location on the card. Do not affix anything else to
the card. Write on the label before affixing it to the
card. If the label is to be written on after it has
been affixed to the card, be sure to use a felt-tip
pen (oil based). Do not use a pencil or ballpoint

pen.
 \

label

Use only MMC (Multimedia Card) cards in your
Nokia Music Player.

If you wish to purchase replacement or additional
memory cards buy a memory card that is the same
size as the one supplied with this device. Bring
your original memory card to the store where you
will purchase a new card and make sure it is the
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Care and maintenance

same size. All cards of the same size work with
your Nokia Music Player.

Keep all memory cards out of the reach of small
children.

The memory card and its contacts can easily be
damaged by scratches or bending, so be careful
when handling, inserting or removing the card.
Before installing the memory card, always make
sure that the Nokia Music Player is switched off.
Do not use or store the memory card in high
temperatures, direct sunlight or high humidity.
Avoid conditions that cause condensation on the
card.

Keep the card away from corrosive materials.
Avoid touching the electrical contacts.

Do not insert the memory card into any other
device such as a digital camera as damage or loss
of information can occur.

Battery

The Nokia Music Player uses one AAA battery. Do
not attempt to use other size batteries.
Turn off your Nokia Music Player before opening

the battery compartment and replacing the battery.

You may use rechargeable batteries in the Nokia
Music Player. Before recharging any battery make
sure that the battery was designed to be recharged
and that you are using the proper device for
recharging.

e Leaving a battery in hot or cold places, such as in

a closed car in summer or winter, reduces the
capacity and lifetime of the battery. Always try to
keep the battery between 15°C and 25°C (59°F
and 77°F). If you use a overly hot or cold battery
with your Nokia Music Player it may temporarily
not work even if the battery has been fully
charged.

Batteries must be recycled or disposed of properly.
Do not dispose of batteries in municipal waste!
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Specifications

Personal computer

Item Requirement

PC IBM PC/AT compatible.

CPU Pentium MMX 266 MHz required. Pentium 300 MHz recommended.

Memory Minimum 48 MB recommended. 64 MB suggested for Windows 2000.

Hard disk 35 MB of free space is required to install the software. Additional free space is

necessary for music files.

Operating System

Windows 98/Windows ME/Windows 2000. This software cannot be used on a
computer running Windows 95/3.1 or Windows NT. Furthermore the software
is not supported on a homemade PC with Windows 98 installed and/or a
computer which has had its system upgraded from Windows 95/3.1 to Windows
98.

Display/Monitor

More than 800 x 600 pixels. More than 65,536 colors, High Color setting.

Browser

Microsoft Internet Explorer or Netscape Navigator, versions 4.0 or higher.

Import file formats supported

ACC, MP3, WAV, CD-DA (music CD)

USB

Version 1.0/1.1 or above.

CD-ROM drivet

SCSI/ANSI X3T10-1048D standard. ATAPI/SFF-8020i standard.

Recommended Soundcard*

Sound Blaster 16 (recommended)

Notes: *The soundcard is not required but without it playback of music with the Nokia Audio Manager on the
personal computer will not be possible.

+CD-ROM speeds may affect quality of encoding
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Specifications

Memory card

Buy a new card

All Multimedia Cards (MMC) should work with it. If you wish to buy new, or additional
memory cards, compare the new card with the card that you have to be sure it is the same
size. Due to continual development of new cards and standards some cards released in the
future may not work correctly in your Nokia Music Player.

Select memory card size
Both 32MB and 64MB size cards are supported.
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Specifications

Suggested encoding bit rates
Nokia Music Player has been especially designed to give you a full 64 minutes of music time
on a 32MB memory card when encoded with AAC.

Music quality Capacity on a Reduction
KkBit/s MP3 AAC 32MB card (minutes) ratio
128 Good *Best 32 11.15:1
96 OK *Better 48 15:1
64 Poor *Good 64 22.5:1

To set the encoding bit rate to use with your Nokia Music Player see View > Options > Read
CD > Bit Rate in Nokia Audio Manager.
*Note: Best = Professional quality

Better = CD quality
Good = Near CD quality
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Upgrading — Nokia Audio Manager

Nokia Audio Manager V1.0 and Nokia CD Manager are standard systems bundled with the
Nokia Music Player.

As long as the end user frequently visits club.nokia.com and registers their Nokia Music
Player serial number during install and at the Club Nokia web site, there may be upgrade
opportunities available to add features to Nokia Audio Manager, Nokia CD Manager and

Nokia Music Player. Other downloadable files may be available.
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Definitions

AAC: AAC stands for Advanced Audio Coding, an encoding format developed by Dolby,
Fraunhofer, AT&T and Sony. AAC is the next generation after MP3. It takes up much less
space on your hard disk or memory card.

Bit rate: Bit rate is generally the sample rate multiplied by the number of “bits per sample.”
When we sample the music, the amplitude or volume has a range that we want to capture,
from very soft to quite loud. That range has to get expressed in digital terms of bits. One
bit gets you “on or off,” not exactly high fidelity. Eight bits gets you 256 levels, which is
not at all bad for speech. Moving up to twenty four bits gets you a whopping 16 million
levels, which is way more than the human ear can actually perceive. So, you take your
sample rate and the chosen number of bits per sample, multiply them together and shove
them down a single piece of wire. This gives you a “bit rate.” In general, the higher the bit
rate, the better the sound quality of the resulting file.

CD quality: CD quality files provide superior sound quality. CD quality files are the least
compressed of your digital music files and will take up more space on your hard drive. If
you select AAC or MP3 format in menu item View > Options > Read CD tab, you have five
choices of quality ranging from a compression rate of 112kBit/s at 11.25 : 1 to 320kBit/s at
4.4:1.

Digital Rights Management: Digital Rights Management (DRM) is the system for end-to-end
copyright protection, content distribution management, content payment and billing
management, to assure the content holders can manage their digital rights.

Firewall: A system that enforces an access policy between an organization’s network and the
Internet for purposes of security. A firewall can limit access and/or some forms of commu-
nication between computers inside an organization and those on the Internet.

Firmware: Software that enables the Nokia Music Player to operate. The core software for
the system.
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Definitions

FM radio quality: FM radio quality is the lowest sound quality. These files take up the least
amount of space. If you choose AAC or MP3 format under menu item View > Options >
Read CD tab, you will record at 64kBit/s at 22.5 : 1 compression.

Genre: A genre is distinctive style or subgrouping of artistic composition.

ISP: Internet Service Provider. The company through which users connect to the Internet.

MP3: MP3 stands for MPEG (Motion Picture Experts Group) Layer 3. MP3 is a music file
format, which is small in size but big in quality. MP3 files are audio files that have been
compressed so that they take up less space on your hard drive. For example, a track in
MP3 format that is 3,062KB in size would be a whopping 33,746KB in .wav format.

Near CD quality: If you have a limited amount of hard disk space, Near CD quality is a good
choice for reading a CD. The sound quality is quite close to CD quality, but the files are
smaller. If you choose AAC or MP3 in menu item View > Options > Read CD tab, you
have two choices of Near CD quality recording. These are 96kBit/s at 15 : 1 or 80kBit/s at
18 : 1 compression.

Sample rate: Sample rate is how often you look at or “sample” the continuously varying
signal we call music.

Upgrading: Getting the latest version of the firmware or software.
WMA: WMA stands for Windows Media Audio.
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